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À Propos de ce Manuel :   
 

 

Ce document s’adresse aux utilisateurs responsables de la création d’activités dans  
CAN-8  
 
Suite à cet atelier, les participants devraient :  
 

• être familiarisés avec l’interface CAN-8 et ses fonctions;  

• reconnaître les différents menus; 

• être en mesure de déterminer quelle fonction utiliser et comment y accéder; 

• avoir une connaissance détaillée des différents types d’exercices; 

• être capables d’ajouter/supprimer/modifier des exercices dans une activité; 

• pouvoir travailler dans plusieurs Planners; 

• savoir comment sauvegarder et publier les activités développées;  

• reconnaître les fonctions associées au Planner et savoir y accéder;  

• avoir une connaissance générales des différentes options.  
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I. Introduction à CAN-8 (ref Online Manual)  
A - Les outils de CAN-8  

 
CAN-8 est un ensemble de 4 outils :  

• Le Planner :  il permet de créer les activités pour les étudiants. 
• Le « Player » ou « programme étudiant » : interface qui présente les activités 

développées. C’est le seul outil commun aux enseignants et aux étudiants dans 
CAN-8.  

• Le Tracker : pour suivre les progrès des étudiants. 
• Une suite d’outils d’administration pour la création de classes,  l’inscription des 

étudiants, les rapports d’activité, etc.  
 

Important : 
o Des fonctions spécifiques sont associées et sont uniques à chaque outil; les 

fonctions relatives au Planner ne sont pas accessibles depuis le Tracker et 
vice versa. 

o L’administrateur du système peut avoir limité votre accès à certains outils. 
Si tel est le cas, vous recevrez une notification lorsque vous essayerez 
d’accéder à l’outil restreint. 

B - Se connecter  
 
Chaque utilisateur à un identifiant et un mot de passe unique. L’identifiant détermine le 
rôle de l’utilisateur dans CAN-8 (instructeur ou étudiant).    
 
Pour vous connecter : 
 

1. Sur votre bureau, double cliquez sur l’icône CAN-8. 
L’écran de connexion s’affichera. S’il est présent, le champ « Server » devrait être 
déjà rempli. 

2. Saisissez votre code identifiant dans le champ « User ID ».  
3. Saisissez ensuite votre mot de passe dans le champ « password » et appuyez sur la 

touche « Entrer » du clavier ou sur l’icône de connexion. 
4. L’interface des enseignants s’ouvrira.  

  

C - L’interface de CAN-8   
 
L’interface de CAN-8 consiste de :   

• 3 barres d’outils. 
• un menu principal. 
• une surface de travail. Celle-ci est vide lorsque vous vous connectez.  
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1. Les barres d’outils :  
Les barres d’outils permettent d’accéder aux fonctions de CAN-8. Il y a trois barres 
d’outils.     

a) Le menu 

Il se trouve dans la partie supérieure de l’interface.   
Il comprend la plupart des outils et des fonctions de CAN-8.  
 

 
.  
Cliquez à gauche sur le menu « File » pour ouvrir le menu contextuel :  
 

 

 

La barre de menu comprend à la fois les liens vers les 
outils nécessaires pour travailler dans CAN-8 et les liens 
vers les fonctions associées à ces outils.  

Notez que certaines entrées dans le menu sont grisées.  

Les fonctions grisées sont celles qui ne sont pas 
associées à l’interface dans laquelle vous vous trouvez 
actuellement.  

La fonction « Print », par exemple sur l’illustration          
ci-contre, ne sera active que lorsque votre interface 
présentera de l’information à imprimer. Il en est de 
même pour « Save » et « Abandon Changes ».  

 

Vous pouvez aussi ouvrir et naviguer ce menu en utilisant les raccourcis clavier.  

1. 1) Identifier la lettre soulignée dans le titre du menu (Dans l’illustration ci-dessus, 
c’est la lettre F de « File » qui est soulignée.) 

2. 2) Appuyez simultanément sur les touches CTRL + F pour ouvrir ce menu.  
3. 3) Identifiez ensuite la lettre soulignée pour le sous-menu ou la fonction qui vous 

intéresse. Par exemple « Create ` » (le symbole ` indique que le lien choisi 
est un sous-menu). 

4. 4) Appuyez sur les touches SHIFT + C pour afficher les liens dans ce sous-menu.  
5. 5) Appuyez une autre fois sur SHIFT + C pour ouvrir le lien « Class ». 
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b) La barre de boutons 

 
 
Elle rassemble les boutons nécessaires pour enregistrer et écouter le son dans CAN-8. 
Ces boutons sont grisés dans l’interface principale. Ils ne sont actifs que lorsque vous 
ouvrez une interface où il est possible d’enregistrer.  

c) La Barre d’Outils :  

Barre verticale de boutons qui se trouve sur la gauche de l’interface.  
 
Cette barre offre des raccourcis vers les outils principaux de CAN-8 : Le Planner, le 
Player, le Tracker, et le Menu principal.  
 
De même que pour les liens du menu et de la barre de boutons, les icônes qui s’y trouvent 
ne sont activées que s’il est possible de les utiliser dans l’interface courante. Ils sont 
grisés lorsqu’ils ne s’appliquent pas.     
 
Activé Pointeur Grisé Outil correspondant 

 

N/A 

MENU- Ouvre ou ferme le menu principal, quelle que soit 
l’interface où vous vous trouvez.  
Ceci permet à l’utilisateur d’ouvrir plusieurs activités et outils.  
Ce bouton est toujours activé.  

  

Pour ouvrir le Player de l’activité sélectionnée.  
Ce bouton est activé seulement si le lien sélectionné dans le 
menu principal est une activité (leçon). Il est grisé si le lien 
sélectionné est un menu ou une tâche administrative.   

  

Donne accès au Tracker pour faire le suivi des étudiants. 
Ce bouton est activé seulement si le lien sélectionné dans le 
menu principal est une activité (leçon). Il est grisé si le lien 
sélectionné est un menu ou une tâche administrative.    

  

Donne accès au Planner. 
Ce bouton est activé seulement si le lien sélectionné dans le 
menu principal est une activité (leçon). Il est grisé si le lien 
sélectionné est un menu ou une tâche administrative.   

 
 

N/A 
Ouvre la fenêtre du téléphone. L’enseignant peut appeler un 
étudiant ou diffuser une annonce aux utilisateurs connectés à 
CAN-8.  
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Ce qu’il faut retenir :  

Si une fonction (un lien dans le menu, une icône ou un bouton) est grisée, ceci indique 
que vous n’êtes pas dans l’outil auquel cette fonction est associée. 

2. Le menu principal 
 
Le menu présente une liste de sous-menus et d’activités qui peuvent inclure quelques 
fonctions administratives internes, des leçons, des liens internet ou média. 
Ce menu peut être personnalisé et peut varier d’un utilisateur à un autre. 
Chaque entrée dans cette liste représente le titre d’un sous-menu, d’une fonction ou d’une 
activité (leçon).  
Quelle que soit l’interface dans laquelle vous travaillez, vous pouvez en tout temps 
accéder à ce menu principal en cliquant sur le bouton.   

 

 
 
1. Cliquez à gauche une fois sur cette icône ouvre le menu 
2. Cliquez à gauche une deuxième fois sur cette icône ferme le menu.   

 
Le type de l’activité listée est reconnaissable à l’icône qui précède son titre. Aux fins de 
cette formation, nous nous concentrerons sur les icônes suivantes :   
  

Icône Type de  
l’activité Description 

 Leçon 

Dès que vous sélectionnez un lien de ce type dans le menu, les 
icônes de fonction (Planner, Tracker et Player) s’activent dans la 
barre d’outils.  
Ils ne s’activent pour aucun autre type d’activité présent dans le 
menu.  

 
Sous-menu 
Fermé  

Permet de simplifier l’affichage du menu sous forme de liste 
imbriquée.  
Un sous-menu peut inclure d’autres sous-menus,  des fonctions 
internes ou des leçons.    
L’accès à CAN-8 des utilisateurs peut être restreint à un sous-menu 
seulement.    

 
Sous-menu 
ouvert 

Une fois le sous-menu ouvert, l’instructeur peut voir et accéder à son 
contenu. 
 
Cliquez sur le caractère - qui le devance pour fermer ce menu et 
cacher son contenu.   
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Un sous-menu peut être ouvert ou fermé. Par défaut, le sous-menu est affiché fermé. Le 
contenu de ce menu est caché pour simplifier l’affichage.  
Un menu fermé est précédé du caractère « + ». 
 

6. Cliquez une fois à gauche sur le signe « + » pour l’ouvrir et afficher son contenu.   
7. L’icône change pour un sous-menu ouvert et est précédée du signe « - ».  
8. Cliquez une fois à gauche sur ce « - » pour fermer le sous-menu.  

 
Le système permet un maximum de 16 menus imbriqués. Les illustrations suivantes 
montrent 4 niveaux de menus imbriqués.  Pour atteindre la leçon intitulée « KAPITEL 
5 », il faut ouvrir ces 4 niveaux.   
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NOTEZ : les icônes des barres d’outils restent grisées si vous sélectionnez un sous-menu. 
Les sous-menus ne possèdent ni Planner, ni Player, ni Tracker.     

II. À propos du Planner 
1. Créer une nouvelle activité - Qui contacter?  

 
Le menu principal ne peut être modifié que par l’utilisateur qui a le code d’identifiant 
MASTER.   
Si vous désirez ajouter un sous-menu ou une leçon dans le menu principal, vous devez 
contacter cette personne et leur indiquer clairement où vous désirez l’insérer, son type 
(leçon ou sous-menu) et son titre. 
   
Une fois l’entrée créée dans le menu, vous pouvez alors ajouter les exercices.  

2. Ouvrir le Planner d’une activité :  
 
Les exercices qui forment une activité sont créés dans le Planner.  
 
Pour ouvrir un Planner :  
 
 

1. Dans le menu principal, identifiez une 
activité de type leçon.  

2. Cliquez une seule fois à gauche sur le titre 
pour le sélectionner. Attention, si vous 
double cliquez sur le titre, la leçon s’ouvrira 
dans le Player.  

3. Cliquez ensuite sur l’icône du Planner dans 
la barre d’outils. 
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3. Publier une leçon pour que les étudiants puissent y 
accéder  

 
Les étudiants ont accès à une activité si et seulement si :  
 

• L’activité se trouve dans une partie du menu qui est commune avec les étudiants.  
 
Si elle est placée dans le menu enseignant, les étudiants ne pourront pas la voir.   
Vous pouvez donc de ce fait prendre le temps de développer une activité dans le menu 
des enseignants puis demander à l’utilisateur avec l’identifiant MASTER de la déplacer 
dans le menu des étudiants une fois qu’elle est complétée.  
 

• Le Planner contient des exercices non vides.  
 
Les exercices vides (sans contenu) ne sont pas affichés dans le Player. Vous pouvez avoir 
un Planner avec un menu qui contient 240 titres d’exercices. Tant que ces exercices ne 
contiennent ni audio, ni texte ni image, le Planner est considéré vide.      
 
Si dans le but de votre leçon vous désirez présenter un exercice vide (sans texte ni audio 
ni image), il faudra alors ajouter un caractère « espace » dans la zône d’édition de texte.  
Ce caractère étant un caractère valide, l’exercice aura alors du contenu, même si celui-ci 
est invisible.   
  

• L’activité est sauvegardée.  
 
Lorsque vous travaillez dans le Planner, tout se trouve au niveau de votre station de 
travail. Pour que d’autres utilisateurs puissent accéder à cette leçon, il faut qu’elle soit 
sauvegardée sur le serveur.  
Les étapes détaillées pour la sauvegarde se trouvent dans la section « VI- Sauvegarder 
votre planner ».  
  

4. Les onglets de fonction 
 
Dès que vous ouvrez une activité, que ce soit dans le Player, Planner ou Tracker, un 
onglet correspondant s’ouvre.   

Il peut y avoir jusqu’à 7 onglets ouverts en même temps.   

  

Un onglet indique trois informations majeures : 
 

• Le titre de l’activité situé au centre de l’onglet.  
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• La fonction utilisée pour ouvrir l’activité.  L’icône sur la gauche vous indique 
si l’activité est ouverte dans : 

o le   Player, 
o le   Planner  
o le    Tracker. 

Dans l’illustration ci-dessus, la même activité (lesson 1) est ouverte à la fois dans 
le Player, le Planner et le Tracker. Il est important lorsque vous développez une 
leçon de pouvoir reconnaître si vous êtes bien dans la bonne fonction (vous ne 
pourrez pas éditer dans le Player par exemple) ou si le Planner est ouvert (les 
exercices qui ont été créés ne seront pas publiés tant que le Planner est ouvert).  

     
• L’état de l’onglet (activé ou désactivé) :  

o Les onglets désactivés sont gris. Ils indiquent que la fonction pour cette 
leçon est ouverte, mais n’est pas la fonction couramment utilisée.   

o L’onglet actif est bleu, et correspond à l’interface en cours d’utilisation.   
 
Note : Il ne peut y avoir qu’un seul onglet bleu.  
L’illustration ci-dessus indique que l’utilisateur se trouve dans le Planner de 
l’activité « Lesson 2 ».  

 
Dans votre menu :  
 

1. Dans votre menu principal, identifiez une activité de type leçon  
2. Cliquez une fois à gauche sur l’activité pour la sélectionner. 
3. Cliquez ensuite à gauche sur l’icône du Planner (Barre d’outils verticale à gauche) 
       Un onglet bleu s’ouvre en même temps que l’interface du Planner est affichée.   
4. Cliquez ensuite sur l’icône du Tracker (Barre d’outils verticale à gauche). Un 

deuxième onglet apparaît, en bleu, cette fois avec le même titre, mais avec l’icône 
du Tracker. L’interface du Planner est remplacée par l’interface du Tracker sur 
votre écran.  

5. Cliquez maintenant sur l’onglet gris. Il devient bleu à son tour et vous avez 
maintenant de nouveau accès à l’interface du Planner.   

Un rappel que certaines options listées dans le menu supérieur seront grisées si elles ne 
s’appliquent pas à la fonction active.   

Pour fermer les onglets :  
 

1. C’est l’onglet actif qui est fermé en premier. Cliquez sur l’onglet que vous désirez 
fermer pour l’activer. 

2. Une fois que l’onglet est bleu, cliquez sur le bouton « Fermer onglet »    
qui se trouve à l’extrême droite de la barre d’onglets.   

3. Répétez ces deux étapes pour chaque onglet.  
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III.  Ajouter des items  
 
Pour créer une activité, il faut : 
 

• Premièrement, créer/ajouter les exercices dans le menu du Planner.  
• Ensuite, ajouter du contenu (texte, audio, image) dans ces exercices.   

1. Créer des items :  
 
Pour créer un nouvel item dans un menu :  
 

1. Cliquez une fois à droite dans le menu - Un menu contextuel s’ouvre.  

 

2. Cliquez une fois à gauche sur « New » (nouveau). Vous obtiendrez un second 
menu contextuel.   

3. Dans la liste présentée, sélectionnez « Teaching Item » (enseignement).   
4. Un item nommé « New Item » est alors ajouté au menu. 

 

5. Saisissez « First Item » dans le champ du titre et appuyez sur la touche ENTRER 
du clavier. 

6. Cliquez ensuite à droite sous « First Item ». 
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7. Un curseur d’insertion représenté par une ligne horizontale noire apparaîtra sous 
l’exercice comme illustré ci-dessous.  

 

 
 
 

8. Cliquez une fois à gauche sur « New » et une fois à gauche sur « Teaching Item » 
9. Tapez ensuite « third item » dans le titre et appuyez sur la touche « ENTER ».    

Vous avez maintenant 2 items créés dans votre menu : 
 

 
 

2. Insérer des items  
Nous allons maintenant créer un autre item entre les deux que nous avons créés dans les 
étapes précédentes.   
 

1. Pour insérer un item, cliquez à droite une fois sous « first item ».  
NOTE :  
Ne cliquez pas à gauche sur « first item » avant de cliquer à droite.  
Ceci sélectionnerait « first item ». Si « first item » est sélectionné - surligné en bleu -  
désélectionnez-le d’abord en cliquant à gauche dans une partie vide du menu. 

2. Vous devriez voir le curseur d’insertion entre « first item » et « third item » 
comme dans l’illustration ci-dessous 
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10. Cliquez ensuite à gauche sur « New » puis sur « teaching item » et saisissez le 

titre « second item ».  
 

9 À retenir :  
Lorsque vous insérez un item dans un menu, vérifiez d’abord que le curseur d’insertion 
se trouve à l’emplacement désiré.  
Si un item est sélectionné (surligné en bleu) le menu contextuel qui apparaîtra ne sera 
pas le menu d’insertion. Désélectionnez l’item avant d’en insérer un autre en cliquant à 
droite sur une partie vide du menu.   

3. Déplacer des items :  
NOTE :  
Si vous essayez de déplacer un item en cours d’édition (ouvert), vous obtiendrez un 
message d’erreur vous avisant de fermer l’item et d’essayer de nouveau.  
 

1. Cliquez ensuite à gauche sous « second item », cliquez à droite sur « New » puis 
sur « Teaching item » 

2. Nommez cet item « fourth item » 
 
Pour déplacer cet item en bas de la liste :  

1. glisser/déposer : 
• Cliquez à gauche sur l’item sans relâcher le bouton de la souris 
• Toujours en gardant le bouton appuyé. Lissez l’item vers sa 

position finale. Le curseur d’insertion vous laisse savoir où se 
trouve le pointeur de la souris.  

• Une fois le curseur à l’enduit désiré, sous « third item » relâchez le 
bouton de la souris.  

 
2. Couper/coller :   

• Cliquez une fois à gauche sur l’item « fourth item » pour le 
sélectionner. Il devient surligné en bleu.   

• Cliquez à droite pour avoir le menu contextuel.  
• Cliquez à gauche sur « cut » ou « couper ».   
• Cliquez ensuite à droite entre « first item » et « second item » et 

assurez-vous que le curseur d’insertion est bien entre les deux 
exercices.   

• Sélectionnez « Paste ».   

IV. Les onglets des exercices.  
 
Pour ajouter du contenu aux exercices, vous devez d’abord ouvrir leur interface . Notez 
que vous pouvez avoir jusqu’à 8 exercices ouverts simultanément. Il est donc nécessaire 
d’être en mesure d’identifier celui qui est actif et en mode d’édition.  
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Pour ouvrir l’interface d’un exercice et ajouter du contenu, il suffit de double cliquer 
deux fois sur l’icône dans le menu.  
 

1. Cliquez deux fois sur l’icône de « first item » 
2. Cliquez deux fois sur l’icône de « second item » 
3. Cliquez deux fois sur l’icône de « third item » 
4. Cliquez deux fois sur l’icône de « fourth item » 
5. Vous avez maintenant 4 nouvels onglets.  

 

 
 
Comme pour la barre des onglets de fonction, l’onglet des exercices comprend les 3 
informations nécessaires, soit le type de l’exercice, indiqué par l’icône, le titre, et le statut 
(actif ou inactif) indiqué par la couleur. Les onglets inactifs sont gris comme pour les 
fonctions, l’onglet actif est orange pour le différencier d’un onglet de fonction.  
 
Dans l’illustration présentée, l’onglet actif est celui de l’exercice « fourth item ». 
L’interface où vous allez travailler est donc celle du 4e exercice.    
 

6. Cliquez à gauche sur « first item ». Celui-ci deveint orange.   
7. Cliquez à gauche sur la zône d’édition de texte et tapez « this is the first item »  
8. Cliquez à gauche sur « second item » qui à son tour devient orange.   
9. Cliquez à gauche dans l’éditeur de texte et tapez « this is the second item » 
10. Faites les mêmes étapes pour les deux derniers exercices.  
11. Cliquez maintenant sur les onglets tour à tour et observez que l’onglet orange 

correspond à l’interface de l’exercice affichée.     
 
Pour fermer un exercice : 

1. Cliquez à gauche sur son onglet pour l’activer 
2. Une fois que l’onglet est orange, sélectionnez le bouton « X » à l’extrémité droite 

de la barre d’onglets.   
3. Répétez ces deux étapes pour chaque onglet.   
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V. Ajouter du contenu aux exercices.  
1. Travailler avec le son 

 L’affichage et le comportement de l’audio variera suivant le type d’exercice dans lequel 
vous le placez.  

Pour ajouter de l’audio dans CAN-8, vous pouvez :  
• Enregistrer votre voix avec un microphone.  
• Importer un fichier audio avec la fonction d’importation.  
• Glisser/déposer un fichier audio dans un exercice.  
• Copier/Coller ou Couper/Coller un fichier audio de votre disque ou de l’audio 

provenant d’un autre exercice CAN-8.  

NOTES :  
1. La durée maximale de l’audio par exercice est de 40 minutes.  
2. Les formats des fichiers audio acceptés sont .wav, .mp3 et certains fichiers  .wma 

Les fichiers .wav doivent être PCM à 44.1, 22.5 ou 11.25 KHz. 
3. Les fichiers .cda qui se trouvent sur les CD audio,  ne sont pas des fichiers audio, 

mais des raccourcis qui mènent aux pistes présentes sur le CD. Vous devrez donc 
convertir ce format cd en format .wav ou .mp3 avant d’importer le son dans  

 CAN-8.  

(1) Enregistrer du son  
1. Dans le menu , double cliquez sur l’icône de « first item » pour l’ouvrir. 
2. L’onglet orange ainsi que l’interface correspondant à cet item s’ouvriront.   
4. Le lecteur l’audio se trouve dans la partie inférieure de l’interface de l’exercice. 

Vous y trouverez les mêmes boutons que dans la barre de boutons qui se trouve 
sur l’interface principale de CAN-8.  Vous pouvez utiliser soit les boutons de la 
barre, soit les boutons dans l’exercice, selon votre préférence personnelle.  
 Cliquez à gauche sur le bouton d’enregistrement pour démarrer l’enregistrement.   

 
5. Cliquez sur le bouton pause pour arrêter l’enregistrement.   

  
6. Pour écouter votre enregistrement, cliquez sur le bouton de lecture ou directement 

dans le graphique audio représentant votre enregistrement.  

 
7. Enregistrez votre voix, puis appuyez sur pause. Enregistrez votre voix une 

deuxième fois, puis de nouveau appuyez sur pause.  Notez que le deuxième 
enregistrement ne remplace pas le premier, mais s’ajoute au premier.   

(2) Importer un fichier audio  
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Avant d’importer un fichier audio, assurez.vous qu’il est bien dans un des formats 
supportés par CAN-8.   

1. Ouvrez l’exercice « second item »  
2. Assurez-vous que l’onglet orange corresponde bien à cet exercice.  
3. Dans le menu supérieur de CAN-8, sélectionnez File > Import > Sound 
4. Dans la fenêtre présentée : 

  
• Sélectionnez le répertoire où se trouve votre fichier audio, 
• Cliquez sur le fichier pour le sélectionner ou tapez le nom du fichier dans le 

champ « File Name »   
•  Si votre fichier n’est pas listé, vérifiez le type de fichier comme illustré ci-

dessus. Si votre fichier est en format MP3, changez le défault « wave files » 
par MP3.  

• Appuyez ensuite sur « open ».  
5. La bande graphique verte apparaîtra dans l’interface audio.   
6.  Pour écouter le son, cliquez directement sur la bande verte ou sur le bouton 

« lecture ».   
 
Note :  
Vous pouvez ajouter de l’audio en enregistrant votre voix ou en important un second 
fichier audio.  

(3) Glisser/Déposer 

Vous pouvez aussi ajouter du son en utilisant une des deux méthodes ci-dessous :  
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1) Si vous pouvez ouvrir vos fenêtres en mosaïque (sans qu’elles se chevauchent) ,  
 

 

• Repérez votre fichier dans votre répertoire  
• Cliquez une fois à gauche sur son titre pour le sélectionner. Gardez le bouton de la 

souris enfoncé.  
• Tout en appuyant sur le bouton, déplacez le pointeur de la souris dans la zône 

audio de CAN-8.  
• Relâchez le bouton pour déposer le fichier audio.  

2) Si vous ne pouvez pas afficher vos fenêtres en mosaïque  

• Repérez le fichier que vous désirez déplacer  
• Cliquez à gauche sur le fichier et gardez le bouton de la souris enfoncé.   
• Déplacez le pointeur de la souris dans la barre des tâches ( en bas de votre bureau)  
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et placez-le au-dessus de l’icône CAN-8.  

 

• L’interface CAN-8 s’ouvrira aprés quelques secondes.    
• Sans relâcher le bouton de la souris, déplacez le pointeur vers la le lecteur audio 

de l’exercice   
• Relâchez le bouton de la souris pour déposer le son.   

(4) Copier/Coller ou Couper/Coller  

Si le fichier se trouve sur un disque 

• Repérez le fichier copy.wav,  
• cliquez à droite sur le fichier pour obtenir le menu contextuel et 
•  cliquez à gauche sur Copier,  
•  Vous pouvez aussi cliquer à gauche sur le fichier pour le sélectionner, puis sur 

EDIT > Copy  dans le menu supérieur.  

 

• Placez ensuite le pointeur de la souris sur le lecteur audio de votre exercice . 
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• Cliquez à droite et sélectionnez PASTE dans le menu contextuel, ou EDIT > 
PASTE dans le menu supérieur de CAN-8.  

• Le graphique audio vert apparaîtra.   

(5) Enlever le son d’un exercice.  
 

1. Cliquez deux fois sur l’icône de l’exercice pour l’ouvrir.  (l’onglet correspondant 
à cet exercice doit être orange)  

2. Dans le menu supérieur, sélectionnez Edit > Clear > Sound 
 
La représentation graphique de l’audio disparaît.   

(6) Éditer le son 
L’édition du son se fait avec la souris. La méthode principale consite à sélectionner puis 
déplacer ou supprimer la partie indésirée du son importé.  
 

• Pour supprimer :  
1. Dans la représentation graphique du son, repérez la partie que vous désirez 

supprimer. Ceci peut être fait soit visuellement, soit à l’aide du compteur qui se 
trouve dessous.  

2. Cliquez ensuite à gauche au début de la partie à enlever et tout en gardant le 
bouton de la souris enfoncé, glissez le pointeur jusqu’à la fin de la section à 
supprimer et relâchez le bouton. La sélection est surlignée en vert foncé.  

 
3. Appuyez sur la touche DEL de votre clavier, ou sélectionnez Edit > Snip dans le 

menu supérieur.  
 

Il est préférable de supprimer le son qui se trouve entre deux « silences ». Un silence 
est indiqué sur la représentation graphique par l’absence de bande verte ou par une 
section où la bande verte est plus proche de l’axe inférieur que les autres. Si vous 
coupez le son au plus haut de la bande, vous risquez d’entendre un clic à l’endroit où 
les deux parties du son sont jointes.   
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• Pour déplacer une section du son :   

1. Sélectionnez la section à déplacer en glissant le pointeur de la souris comme 
décrit dans la procédure précédente.  

 

2. Cliquez (gardez le bouton de la souris enfoncé) sur la partie vert foncé 
sélectionnée.  

3. Déplacez le pointeur à l’endroit où vous désirez déplacer le son et relâchez le 
bouton de la souris.  

Comme pour la suppression, le résultat obtenu sera plus efficace si vous déposez la 
sélection entre 2 silences.  

• Si vous avez supprimé ou déplacé du son par erreur  

Sélectionnez Edit > Undo dans le menu supérieur.   

2. Ajouter du texte  
 
Vous pouvez utiliser une des méthodes suivantes :  

• Saisir le texte au clavier ou a l’aide d’un des claviers virtuels.  
• Importer un fichier texte.  
• Glisser/déposer du texte   
• Copier/Coller du texte  

a) Avec votre clavier :  

1. Cliquez sur l’éditeur de texte de l’exercice à l’endroit où vous voulez débuter.  
2. Saisissez votre texte comme dans un éditeur normal.   

 
Pour accentuer des caractères :  

1. Cliquez à droite devant le caractère à accentuer. 
2. Cliquez sur « accent » dans le menu contextuel  
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3. Une fenêtre avec les accents disponibles apparaît. Cliquez sur l’accent de votre 
choix    

 
Méthode alternative : 
 

1. Tapez le caractère à accentuer. 
2. Appuyez simultanément sur les touches CRTL + A du clavier pour faire 

défiler les variations possibles du caractère jusqu’à ce que vous obteniez celle 
voulue.    

b) Importer un fichier texte 

1. Cliquez deux fois sur l’icône de l’exercice pour l’ouvrir 
2. Sélectionnez FILE > IMPORT > TEXT dans le menu supérieur 
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c) Glisser/Déposer  

1. Ouvrez le document ou la page web que vous voulez copier. 
2. Ouvrez un exercice CAN-8  
3. Dans le document, cliquez au début du paragraphe que vous désirez sélectionner, 

et en gardant le bouton de la souris enfoncé, faites glisser le pointeur de la souris 
jusqu’à la fin du paragraphe. Relâchez ensuite le bouton de la souris pour faire la 
sélection.  

4. Mettez ensuite le pointeur de la souris au-dessus du paragraphe sélectionné puis 
tout en gardant le bouton de la souris pressé, glissez la sélection au-dessus de la 
l’éditeur de texte de CAN-8, où vous voulez glisser le texte.   

5. Relâchez le bouton de la souris  

d) Copier/Coller ou Couper/Coller.  

1. Ouvrez le document ou la page web que vous désirez copier. 
2. Ouvrez un exercice CAN-8  
3. Dans le document, cliquez au début du paragraphe que vous voulez sélectionner, 

et en gardant le bouton de la souris enfoncé, faites glisser le pointeur de la souris 
jusqu’à la fin du paragraphe. Relâchez ensuite le bouton de la souris pour faire la 
sélection. 

4. Cliquez à droite sur la sélection puis cliquez sur COPY ou sélectionnez EDIT > 
COPY dans le menu supérieur.  

5. Cliquez ensuite dans l’éditeur de texte de l’exercice CAN-8 et vous pouvez soit 
cliquer à droite puis choisir PASTE dans le menu contextuel, soit sélectionner 
EDIT > PASTE dans le menu supérieur.    

 
Vous pouvez également utiliser les raccourcis du clavier ( CTRL + C pour copier le texte 
sélectionné, CTRL + X pour le couper, CTRL + V pour le coller dans CAN-8)  

3. Ajouter des images  
Les images doivent être de format JPG, BMP ou GIF et leur taille maximale de 320 
pixels horizontalement par 240 verticalement. Si l’image est plus grande que la taille 
maximale, seuls les premier 320 pixels horizontaux et 240 pixels verticaux en partant du 
coin supérieur gauche seront importés.  
 
Suivant le type de l’exercice dans lequel vous ajoutez une image, celle-ci sera située sur 
la droite ou sur la gauche de l’exercice ou en image de fond.    

a) Copy/paste 

Les images peuvent être copiées d’un disque dur ou d’un disque amovible. Certains sites 
internet vous permettront aussi de le faire.   

1. Cliquez deux fois sur l’item pour l’ouvrir.  
2. Trouvez votre fichier sur votre disque.  
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3. Cliquez à droite sur le fichier et sélectionnez Copy dans le menu contextuel.  
4. Dans l’exercice CAN-8, cliquez à droite et sélectionnez Paste dans le menu 

contextuel.  

Vous pouvez également utiliser : 

5. EDIT > COPY dans le navigateur internet, ou sur votre disque puis EDIT> 
PASTE dans CAN-8  

6. Les raccourcis du clavier tels que CTRL + C pour copier le texte sélectionné, 
CTRL + X pour le couper, CTRL + V pour le coller dans CAN-8.  

b) Glisser/Déposer  

Glissez une image qui se trouve sur un disque dur ou un disque amovible, ou encore sur 
une page web (notez bien que certains sites web et certains navigateurs ne permettent pas 
la fonction Glisser/Deposer. Vous obtiendrez une URL à la place de l’image.  Vous 
pourrez cependant utiliser copier/coller dans la plupart des cas.  

1. Ouvrez l’exercice dans CAN-8 
2. Cliquez sur le fichier ou sur l’image en gardant le bouton de la souris enfoncé 
3. Glissez l’image jusqu’à l’exercice CAN-8 
4. Relâchez le bouton. 

Pour trouver une image de la taille désirée dans Google :  

1. Ouvrez votre navigateur internet 
2. Tapez https://images.google.com/ 
3. Dans le champ de recherche tapez : clipart 320 X 240 – Les images proposées 

seront de la taille voulue ou très proche.  

c)  Importer une image :  

1) Ouvrez l’exercice CAN-8 dans le Planner.  
2) Sélectionnez FILE > IMPORT > IMAGE dans le menu supérieur 
3) Cliquez sur le fichier de l’image dans la fenêtre d’import puis sur OPEN.  

4. Synchroniser le texte avec le son.  
 
Lorsque le texte et le son sont synchronisés, le texte correspondant au son joué est 
surligné en cyan. De même, cliquer sur des mots qui ont été synchronisés démarre la 
lecture du son correspondant.  
 

1. Dans le menu du Planner, créez un nouvel item de type « Teaching » et nommez 
le  « Sync » 

2. Dans l’exercice, tapez le texte suivant :  
3.  Days of the week 
4.  Monday 
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5.  Tuesday 
6.  Wednesday  
7.  …  
8. Enregistrez clairement et à haute voix ce que vous venez de taper.  
9. Écoutez maintenant la bande audio en prêtant attention où commence et finit 

chaque mot.  Vous pouvez aussi utiliser le compteur pour vous aider à repérer le 
début d’un mot dans la bande sonore.  

10. Dans le texte, cliquez une fois devant le mot « Monday » . 
11. Dans la bande sonore, cliquez une fois au début du son correspondant. Le curseur 

sonore restera en position. Ne démarrez pas la lecture du son.  
12. Sélectionnez TEXT > SYNC TO SOUND dans le menu supérieur. Le mot 

Monday sera surligné en cyan.  
13. Cliquez devant le mot Tuesday,  
14. Dans la bande sonore, cliquez une fois au début du son correspondant.  
15. Sélectionnez TEXT > SYNC TO SOUND dans le menu supérieur. Le mot 

Tuesday sera surligné en cyan 
16.  Répétez ces trois étapes pour chaque jour de la semaine.  

 
NOTE :  
S’il est nécessaire d’écouter le son entre deux synchronisations, cliquez deux fois sur la 
bande sonore pour démarrer la lecture. Pour continuer la synchronisation, il faudra 
toujours commencer par cliquer devant le texte puis cliquer sur la bande sonore.   
.  

VI. Sauvegarder votre travail 
Votre travail est automatiquement sauvegardé sur le serveur lorsque vous quittez le 
Planner.  
 
1) Avant de fermer le Planner, fermez tous les exercices ouverts ( appuyez sur le bouton 
X à l’extrême droite de la barre des onglets.)  
2) Fermez ensuite le Planner. Cliquez sur le X sur la droite de l’onglet bleu. 
Votre activité est alors sauvegardée. Les étudiants y ont accès.   
 
Pour voir l’activité telle qu’elle sera vue par les étudiants,  

a) Cliquez sur l’icône du Player dans la barre des outils de gauche.  
b) Ou cliquez sur l’icône du menu puis double cliquez sur le titre de l’activité dans le 
menu.  

VII. Créer différents types d’exercices.  
1. Les différents types d’exercice 

Cette table résume les types d’exercices qui peuvent être créés. Des 
informations détaillées sur chaque type sont données dans la section suivante.  

Note : Les exercices suivis du caractère * sont corrigés par l’ordinateur. 
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Utilisez un exercice de 
type : 

Si vous souhaitez : 

Introduction Commencer ou diviser votre menu en sections. -    
Teaching  Enseigner un concept ou donner des explications 

sur les exercices qui suivent. 
Multiple Choice *  Offrir un choix entre plusieurs réponses.   
Fill-in-the-Blanks * Cacher quelques mots qu’il faudra saisir 
Example  Offrir un modèle en exemple  
Verify  Offrir le modèle de la réponse qui pourra être 

comparé après avoir répondu.  
Conversation Simuler une conversation (combiné avec un 

exercice de type Example ou Verify) 
Simultaneous  Enregistrer pendant que le modèle joue.   
Ask and Answer Créer une question ouverte. 
Read Lire et enregistrer un texte, résumer oralement un 

texte ou offrir une réponse orale à une question 
écrite.  

Write Répondre à l’écrit à une question orale ou une 
dictée.  

2. Les exercices de type  Introduction  
Peuvent inclure : audio et image. Pas de texte. 
 

Les exercices de type Introduction permettent : 
o De diviser votre activité en sections 
o De donner des informations qui seront jouées en début de section. 
 
Typiquement, un item introduction inclut les droits d’auteurs, des informations générales 
relatives à l’activité ou à la section.   
 
Ce sont les seuls items qui peuvent être laissés vides et apparaître dans le Player. 
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Dans l’illustration ci-dessus, l’activité est 
divisée en trois sections. Grammar,  
Vocabulary, et Test. Ces trois sections 
sont délimitées à l’aide d’exercices de 
type Introduction. ENG001 est l’item qui 
vient par défaut avec le Planner. Il a été 
renommé.  

 
Les caractères « + » qui précèdent chaque 
section qu’elles incluent des exercices. Si 
vous cliquez sur le « + », vous pourrez 
alors voir chaque item, comme sur 
l’illustration de droite.   

 
 
     
 

 

Pour créer un item Introduction.  
1. Dans le Planner, créez un nouvel item et sélectionnez Introduction dans le menu 

contextuel.  

2. Nommez cet item. Si vous désirez utiliser cet item pour créer une section, vous avez 
terminé.  

3. Si vous voulez ajouter une image de fond pour la section entière, ajoutez une image. 
Vous pouvez également ajouter de l’audio qui jouera automatiquement dès que la 
section débutera.  
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3.  Exercices de type Enseignement (Teaching Item) 
Peuvent inclure : audio, texte image ou vidéo.  
 
Les étudiants ne peuvent pas soumettre de réponse à ce type d’item.  
 
Créez un item de type Teaching : 

• pour expliquer un concept grammatical.   
• Pour poster des informations sur la section, des instructions, des explications sur 

les exercices qui suivront, une liste de mots ou une conversation audio sur 
laquelle les exercices suivants seront basés.  

  
Pour créer un exercice de type « Teaching » : 

1. créez un nouvel item dans le menu du Planner et choisissez « teaching item » dans 
le menu contextuel.   

2. Nommez puis ouvrez l’exercice.  
3. Ajoutez le média désiré ( audio, texte, image).  

4. Questions de type Choix Multiple 
Doivent inclure du texte  
Peuvent inclure du son et une image.  
 
Créez un Choix Multiple si vous voulez que l’étudiant choisisse une réponse parmi 
plusieurs proposées. La question peut être orale ou écrite.  
 
CAN-8 corrige automatiquement ce type d’exercice. Si une note a été donnée dans le 
Planner, CAN-8 calculera le score.   
 
Lorsqu’ils soumettent leur réponse, les étudiants reçoivent un feedback indiquant la 
réponse correcte ; cependant si l’activité est placée en mode TEST et une note a été 
assignée à l’exercice, l’étudiant ne recevra aucun feedback.  
 
Pour créer un Choix Multiple : 
1. Ouvrez un Planner. Créez un nouvel item et sélectionnez Choix Multiple.   
2. Nommez l’exercice puis ouvrez-le.   
3. Tapez la question .  
4.  Insérez une ligne vide sous la question, puis tapez les réponses proposées, chaque 

réponse sur une ligne différente.  
            Exemple :   
             Select the correct answer :   
             Jim likes to play with Sarah. 
              
             He likes to play with her. 
             He likes to play with herself. 

 She likes to play with him. 
             He likes to play with them.  
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5. Cliquez sur la ligne où se trouve la première réponse.  
            | He likes to play with her 
6. Dans le menu supérieur, sélectionnez Text > Tag Answer 

 
Un chiffre sur fond rouge apparaît en début de ligne indiquant une réponse 
incorrecte.  

7. pour indiquer une réponse correcte, sélectionnez Text > Tag answer une deuxième 
fois et le chiffre apparaîtra sur fond vert.  

8. Répétez les étapes 5 et 6 pour chaque réponse incorrecte, 7 pour la réponse Text > Tag 
correcte.   

 
Multiple Choice in the instructor's 

window 
Multiple Choice as seen by the student.  

 
 

9. pour désélectionner une réponse, sélectionnez Text > Tag answer une troisième fois.    
 
Note :  

• Vous pouvez sélectionner plus d’une bonne réponse. L’étudiant n’aura 
qu’à en sélectionner une seule pour obtenir les points.  

• Par défaut, les choix sont présentés dans un ordre aléatoire. (voir 
illustration ci-dessus) vous pouvez changer ce défaut dans les propriétés 
de l’item.   

• Si vous désirez ajouter du texte en dessous des choix proposés, il faudra 
enlever l’option aléatoire ou le texte sera randomisé aussi et pourra 
apparaître entre deux choix.   

5. Exercice de  type À Compléter (Fill in Items) 
Doivent inclure du texte  
Peuvent inclure audio et image 
. 
Les étudiants doivent saisir du texte dans des champs réservés.  
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Pour créer un exercice de type Fill in 
1. Ouvrez le Planner et créez un nouvel item. Sélectionnez « Fill In Item » dans le 

menu contextuel.  
2. Nommez cet exercice et ouvrez-le.   
3. Saisissez le texte ou la phrase que les étudiants devront compléter, y compris le 

texte à cacher.  
4. Créer les espaces à compléter : 
• Pour cacher un seul mot,  

a. Placez le pointeur devant la première lettre du mot puis cliquez une fois.  
b.  Selectionnez Text > Tag Answer dans le menu. 

• Pour cacher plusieurs mots consécutifs 
a. Cliquez devant la première lettre du premier mot en gardant le bouton de 

la souris enfoncé,  
b. Gisser la souris jusqu’à la dernière lettre du dernier mot à cacher puis 

relâcher le bouton de la souris.   
c. Selectionnez Text > Tag Answer dans le menu. 
 

5. The text background will turn black:  
 
Planner display : 
 

 
 
Student display of the same exercise:  
 

 
 
Note :  Si par inadvertence vous avez sélectionné un mot ou des lettres qui n’auraient pas 
du l’être :   

1. Sélectionnez le texte en glissant la souris sur le texte à montrer.  
2. Selectionnez Normal dans le menu Text. 

6. Exercices de type Exemple.  
Doivent inclure du son  
Peuvent inclure du texte et une image 
 
Les étudiants devront écouter un exemple audio et le répéter. Dans l’écran étudiant, les 
deux représentations graphiques du son seront présentes, l’exemple offert et leur 



 

Page 32 of 43 

rendit6ion. Ils pourront passer d’une bande sonore à une autre pour perfectionner leur 
réponse. 
 
Pour créer un exercice de type Exemple :  
 

1. Ouvrez le Plnner et créez un nouvel item, puis sélectionnez « exemple item » dans 
le menu contextuel.  

2. Nommez-le puis double cliquez sur son icône pour ouvrir l’exercice.   
3. Enregistrer, importez, collez ou glissez l’extrait sonore que l’étudiant devra 

reproduire.  
Note :   
Vous pouvez ajouter du texte et le synchroniser pour les débutants. :  
Si vous voulez rendre l’exercice un peu plus difficile, n’ajoutez pas le texte.  
  

7. Exercices de type Vérifier (Verify item)  
Doivent inclure du son 
Peuvent inclure du texte et une image.    
 
Choisissez un exercice de type Vérifier si vous voulez que l’étudiant enregistre leur 
réponse puis la compare avec celle proposée.  
 
Voici un exemple d’exercice Vérifier dans une leçon sur le passé des verbes irréguliers.   
 

1. Ouvrez un Planner , créez un nouvel item et sélectionnez « verify Item » dans le 
menu contextuel .  

2. Nommez-le puis ouvrez-le.   
3. Tapez une question ou une liste de mots.  

par exemple  What did you eat yesterday? [a banana] 
4. Enregistrez la réponse:  I ate a banana. 

 
Les étudiants devront lire la question, enregistrer une réponse qu’ils pourront comparer 
au  modèle proposé. Ils ne pourront pas écouter le modèle avant d’avoir enregistré leur 
réponse, mais pourront la corriger avant de la soumettre.  

8. Exercices de type Conversation 
Ne peuvent contenir que de l’audio 
Pas de texte, pas d’image.   
 
Les items Conversation simulent une conversation simple. Ils doivent être combinés avec 
un exercice de type Exemple ou Vérifier.  
 
Note : L’item Conversation n’a pas d’interface et n’apparaît pas dans le menu des 
étudiants. L’audio inclut dans cet exercice est simplement attache à l’exercice qui le suit.  

a) Exercice Conversation précédant un exercice Exemple :  
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1. Ouvrez le Planner et créez un nouvel item puis sélectionnez Conversation dans le 
menu contextuel.   

2. Nommez l’exercice puis ouvrez-le.   
3. Enregistrez la question  What did you eat yesterday? 
4. Fermez l’item 
5. Créez un deuxième item sous celui-ci puis sélectionnez Example dans le menu 

contextuel.   
6. Nommez-le puis ouvrez-le. 
7. Dans l’éditeur de texte tapez : a banana  
8. Enregistrez : I ate a banana 
9. Fermez l’exercice.  

 
Un seul de ces deux items sera listé dans l’écran étudiant. Seul le contenu de l’item 
Example sera affiché. Le son de l’item conversation n’aura pas de représentation 
graphique. Les étudiants qui ouvriront l’exercice « Exemple » entendront la question 
comprise dans l’item Conversation puis le modèle réponse enregistrée dans l’écran 
« Exemple ».  Ils pourront alors se baser sur l’exemple proposé pour soumettre leur 
réponse.   

b) Exercice Conversation précédant un item Verifier  

1. Ouvrez le Planner et créez un nouvel item puis sélectionnez Conversation dans le 
menu contextuel.   

2. Nommez l’exercice puis ouvrez-le.   
3. Enregistrez la question  What did you eat yesterday? 
4. Fermez l’item 
5. Créez un deuxième item sous celui-ci puis sélectionnez Verify dans le menu 

contextuel.   
6. Nommez-le puis ouvrez-le. 
7. Dans léditeur ed texte, tapez : a banana 
8. Enregistrez : I ate a banana 
9. Fermez l’exercice.  

 
Comme ci-dessus, de ces deux items, seul l’exercice Vérifier sera listé dans l’écran 
étudiant. Les étudiants entendront la question de l’item Conversation puis devront 
enregistrer leur réponse avant de pouvoir la comparer avec le modèle offert.    

9. Les exercices de type  Ask/Answer   
Peuvent contenir, texte, image , audio  
 

Les exercices de type « Ask/Answer » sont faits pour des questions ouvertes 
orales auxquelles les étudiants devront proposer une réponse, sans modèle.  

Par exemple : 

�  « Tell me about yourself »  

� « Summarize the story you heard »  
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� « What three things did you like about the story? » 

Pour créer un exercice « Ask/Answer » : 
1. Ouvrez le Planner et créez un nouvel item puis sélectionnez « ask/Answer » dans 

le menu contextuel.   
2. Nommez l’exercice puis ouvrez-le.   
3. Enregistrez votre question. 
4. Fermer l’exercice.   

10. Exercices de type Simultané  (Simultanous) 
Doivent contenir de l’audio 
Peuvent contenir du texte et une image.  
 
Les exercices simultanés permettent de 

• Maintenir un rythme approprié dans la langue étudiée. 
• Simuler et s’exercer pour interpréter une conversation d’une langue à une autre. 

 
Le son inclus dans un item Simultané ne joue que si l’étudiant enregistre en même temps. 
Les étudiants ne peuvent pas écouter la bande sonore avant de s’enregistrer, mais 
pourront comparer les deux une fois leur enregistrement terminé.   

Pour créer un item Simultané : 
1. Ouvrez le Planner et créez un nouvel item puis sélectionnez « Simultaneous» dans 

le menu contextuel.   
2. Nommez l’exercice puis ouvrez-le.   
3. Enregistrez ou importez l’extrait audio que l’étudiant devra traduire.  
4. Fermer l’exercice.   
 

11. Exercices de type Lecture  (Read item)  
Doivent contenir du texte 
Peuvent contenir une image 
Ne peuvent pas contenir de son ni de vidéo.   
 
Les étudiants doivent lire et enregistrer un texte, ou répondre oralement à une question 
ouverte écrite.   

Ces exercices permettent d’évaluer le progrès au niveau de la prononciation et de la 
compréhension ainsi que pour pratiquer le stress, le rythme et l’intonation des phrases. 
 

Pour créer un exercice de type « Lecture » 

5. Ouvrez le Planner et créez un nouvel item puis sélectionnez « Read Item» dans le 
menu contextuel.   

6. Nommez l’exercice puis ouvrez-le.   
7. Tapez/importez/collez un paragraphe.   
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1. Indiquez dans l’énoncé si l’étudiant doit enregistrer le paragraphe proposé 
(emphase sur la prononciation ou sur le rythme de la phrase) ou répondre à une 
question sur le paragraphe. ( Pourquoi l’auteur a-t-il….?  Êtes-vous d’accord avec 
l’auteur… ?  Résumez en quelques phrases le sujet du paragraphe) 

2. Fermez l’exercice. 

12. Exercices de type Dictée (Write item)  
Ne peuvent inclure que du son. 
 
Les étudiants soumettent une réponse écrite à un stimulus oral. Ces exercices sont aussi 
parfaits pour une dictée. 
 
Les étudiants peuvent imprimer leur réponse ou la sauvegarder. 

Pour créer un exercice de type Dictée : 
1. Ouvrez le Planner et créez un nouvel item puis sélectionnez « Write Item» dans le 

menu contextuel.   
2. Nommez l’exercice puis ouvrez-le.   
3. Enregistrez/importez/collez un extrait sonore.   
4. Indiquez dans l’énoncé si l’étudiant doit taper ce qu’il entend, répondre à une 

question (emphase sur la prononciation ou sur le rythme de la phrase) ou répondre 
à une question sur le paragraphe. (Pourquoi l’auteur a-t-il…?  Êtes-vous d’accord 
avec l’auteur…?  Résumez en quelques phrases le sujet du paragraphe). 

5. Fermez l’exercice. 
 

VIII. Options des exercices 
Les options n’affectent que l’exercice dans lequel elles ont été configurées.  Elles se 
trouvent principalement dans la fenêtre de propriétés de l’exercice.  
 
Pour ouvrir les Propriétés, dans le menu du Planner :  

3. Sélectionnez l’exercice (cliquez une fois sur son icône)   
4. Cliquez ensuite à droite pour ouvrir le menu contextuel.  
5. Sélectionnez Properties.  
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Certaines propriétés ne s’appliquent qu’à un type précis d’exercice alors que d’autres 
s’appliquent à tous les types.  

1 – Pour tous les types 

1. Item Name:  
Si vous voulez changer le titre de votre exercice.   

2. Type 
Vous pouvez changer le type que vous avez donné à votre item à sa création. Cliquez sur 
le bouton radio correspondant au nouveau type.  Le contenu (texte, audio, image) reste 
dans l’exercice à moins que cet exercice ait une restriction au niveau du contenu : par 
exemple changer un item de type Exemple à un item de type Lecture supprimera la bande 
sonore.  

3. Item Mark (Note maximale par item)   
 
Cette option est active pour tous les types d’items qui exigent une réponse des étudiants. 
Elle est grisée dans les exercices de type Introduction, Teaching et Conversation.  
 



 

Page 37 of 43 

 

 
 
 
Les notes sont prédéfinies dans le système 
et représentent le score maximal que 
l’étudiant peut obtenir pour cet exercice.   
 

 

4. Play Limit (Limite de Lecture) 
 
Cette option vous permet de limiter si, pendant un test, l’extrait sonore que vous avez 
inclus peut être écouté à volonté ou est restreint à une, deux ou trois lectures seulement.  
 
 

 

Il y a 4 options.  

• No limit- Vient par défaut.  
L’étudiant peut écouter l’extrait 
sonore sans limites  

• Once only - La lecture du son 
pendant un test pour cet exercice est 
limitée à une seule fois.   

Up to 2X et up to 3X limite la lecture à 
deux et trois fois respectivement, ou moins.  

Si la limite est atteinte, l’étudiant ne peut 
plus écouter l’extrait audio pour le reste du 
test, même s’il revient en arrière plus tard.   
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2 – Options pour les exercices À Compléter (Fill in)   

5. Part Marks Given  (note partielle)   
 
Cette option ne s’applique qu’aux exercices fill-in. Elle est grisée pour les autres 
exercices.  
 
Les exercices de type Fill in sont notés par l’ordinateur.  
Par défaut, s’il y a plusieurs espaces à remplir dans l’exercice et une des réponses est 
incorrecte ou la question est incomplète, la note attribuée pour l’exercice est 0.  
 
Si toutefois la question contient plusieurs espaces à compléter, et l’option Part Mark est 
cochée, la note maximale attribuée est alors divisée par le nombre d’espaces à compléter : 
pour 2 espaces, chacun compte pour la moitié de la note; s’il y a 3 blancs, chacun compte 
pour 1/3 de la note. Si la réponse soumise contient 2 mots corrects et un faux, la note sera 
donc 2/3 au lieu de 0/3.  
Pour que la note donnée soit précise, il est préférable d’attribuer une note divisible par le 
nombre d’espaces à compléter.  Ex : choisissez _/9 si vous avez 3 blancs plutôt que  
 _/8. 

6. Match Case (Min/Maj) 
Cette option est spécifique aux exercices fill-in. Elle est grisée pour les autres exercices 
 
Par défaut, les erreurs de majuscules et de minuscules sont ignorées et la note complète 
est attribuée à l’exercice.  
Dans certains cas toutefois, il est important de respecter les majuscules. Si vous 
sélectionnez cette option, les réponses soumises avec des erreurs de majuscules seront 
considérées fausses.   

3 – Mode aléatoire pour les questions Choix Multiple 
 
Cette option ne s’applique qu’aux exercices Choix Multiple.  
Pour éviter que les étudiants mémorisent l’ordre des réponses ou copient les réponses, les 
choix multiples sont présentés dans un ordre différent pour chaque étudiant et chaque fois 
qu’ils se connectent 
 
Pour changer cette valeur par défaut et avoir les réponses affichées dans l’ordre exact où 
ils étaient à l’origine, décochez la case « randomize » dans les Propriétés des exercices.  
 
NOTE : Si vous avez ajouté du texte en dessous de la liste des choix, ce texte sera aussi 
présenté de façon aléatoire et peut apparaître entre deux questions. Vous devrez donc 
décocher cette option.   
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IX. Les options du Planner  
 
Contrairement aux options des exercices qui n’affectent qu’un seul exercice, les options 
Planner s’appliquent à tout le Planner et affectent tous les exercices qu’il contient.  
 
Pour accéder à ces options, vous devez : 
 

1. Sélectionner une activité dans le menu principal  
2. Ouvrir le Planner de l’activité. 
3. Sélectionner OPTIONS -> Planner dans le menu supérieur.  

 
NOTE : Ces options sont grisées si le Planner n’est pas ouvert et actif. (onglet bleu).  

1 - Ralenti (Slow Enable) 
 
Cette option est activée par défaut.  
Les étudiants peuvent ralentir ou accélérer la lecture du son à leur guise.   
 
S’il est important qu’ils ne puissent pas ralentir le son, décochez l’option Slow Enabled 
dans le menu Options > Planner. 

2 - Legacy Window Size  
 
Permet d’afficher les activités développées dans une ancienne version de CAN-8 dans 
leur format d’origine.  
 
La taille de l’affichage est donc réduite à celle qui était disponible quand l’activité a été 
développée. Les alinéas, la synchronisation du texte et du son entre autres restent comme 
ils étaient alors.  
  
Il n’est pas possible d’utiliser cette option lorsque vous développez une nouvelle activité.  
 
Si vous décochez cette option, l’affichage de l’activité aura la même taille que pour les 
nouvelles développées dans cette version. Il faudra cependant ouvrir le Planner de cette 
leçon et vérifier le format du texte de chaque exercice. Si le texte est reformaté, la 
synchronisation avec le son doit être refaite.  

3 – Mode de sélection (Item Selection) 

Détermine la présentation de l’activité dans le programme étudiant.  
 
Il y a 4 paramètres :  
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1. Menu 
Mode par défaut à la création d’une activité.  
 
L’activité est présentée avec un menu sur la gauche, et une zône de travail sur la droite 
(voir illustration). Ils peuvent sélectionner les exercices dans l’ordre de leur choix, et les 
refaire autant de fois qu’ils le désirent.  
 
Quand une activité avec un menu est mise en mode test, les étudiants peuvent redémarrer 
le test et reprendre chaque question.   
  

2. Séquence 
Si vous changez le mode par défaut pour « séquence » , le menu de la leçon disparaît 
dans le programme étudiant. La surface des exercices est agrandie pour couvrir celle où 
se trouvait le menu.   
 
Les exercices sont présentés les uns après les autres, dans l’ordre exact de celui du 
Planner, jusqu’à la fin de la leçon. Les étudiants ne peuvent plus choisir l’ordre des 
réponses.  

Note  

• Si l’activité est placée en mode séquence et en mode test, les étudiants qui ont 
répondu à toutes les questions ne peuvent plus refaire le test ni changer leur 
réponse jusqu’à ce que celles-ci soient évaluées et supprimées du Tracker.  

• En mode pratique l’étudiant qui atteint la fin de l’activité peut la recommencer 
depuis le début 

• En mode test et pratique, si l’étudiant se déconnecte avant d’avoir terminé 
l’activité, seuls les exercices suivant la dernière réponse leur seront présentés.  

3. Mode Aléatoire (Random) 
Dans ce mode comme dans le mode Séquence, le menu n’est pas présent.  
 
Les questions sont présentées dans un ordre aléatoire. Ceci permet à la fois d’assurer 
l’intégrité du test et empêcher la mémorisation de l’ordre des réponses.  
 
Note :  

• Si l’activité est divisée en sections (ex. : grammar, vocabulary, etc.), chacune 
séparée par un exercice de type Introduction, les exercices de la même section 
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sont présentés dans le désordre jusqu’à ce qu’ils aient tous une réponse 
enregistrée, après quoi les exercices de la section suivante sont présentés.   

• Les exercices de type Conversation et Teaching apparaissent toujours devant 
l’item qu’ils devancent dans le menu.  

4. Bouton « Retour » (Enable Back Button) 
Cette option permet aux étudiants de retourner en arrière s’ils ont laissé un exercice pour 
plus tard ou s’ils veulent réviser leurs réponses.   
 
Cette option est active par défaut.   
 
Si cette option est désélectionnée, les étudiants ne pourront pas revenir en arrière à moins 
que la leçon soit en Menu .   

4 –Suivi  (Feedback) 
Le feedback est fourni par CAN-8 pour les items de type À Compléter et Choix 
Multiple. C’est la réponse de l’étudiant qui est corrigé par CAN-8 qui peut alors soit 
indiquer que la réponse était incorrecte, soit offrir la bonne réponse.  
 
Vous avez le choix entre 3 sortes de suivi : 
 

 
 

1. Pas de suivi (No Feedback) 
 
L’étudiant ne reçoit aucun feedback et ne sait pas si sa réponse est fausse. Une fois que la 
réponse est soumise, l’étudiant devra procéder au prochain exercice.  
 

2. Correct/Incorrect – (Incorrect Answer Feedback) 
 
Indique uniquement si la réponse est correcte ou non. Cette option ne dévoile pas la 
réponse. L’information est affichée à côté du bouton next. 
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3. Full Feedback 
 
Option sélectionnée par défaut, elle indique si la réponse est fausse ou non et affiche la 
bonne réponse si la éponse soumisse est fausse. 
 

 
Les corrections sont surlignées en vert, sous la réponse de l’étudiant.  
 

  
 
  
 
Les options feedback s’appliquent généralement lorsque les leçons sont en mode 
pratique. En mode « test » si les questions ne sont pas notées, l’étudiant reçoit le même 
suivi. Si par contre les exercices sont notés, l’étudiant ne reçoit aucun suivi. 
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